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We have a jam-packed eZine issue for you 

this month, and the SONAR updates to go 

with it. The big Ipswich news is real-time, 

direct recording of instrument tracks, but 

ǘƘŀǘΩǎ ƴƻǘ ŀƭƭΦ 9ȄǇƻǊǘƛƴƎ Ƨǳǎǘ ōŜŎŀƳŜ ŀ ǿƘƻƭŜ 

lot easier thanks to export presets and the ability to export multiple, individual clips 

simultaneously. Ipswich also sees the addition of MixStrips and Style Dials to SONAR Artist, as 

ǿŜƭƭ ŀǎ tǊƻ/ƘŀƴƴŜƭ ǾŜǊǎƛƻƴǎ ƻŦ ǘƘŜ {ǘȅƭŜ 5ƛŀƭǎ ŦƻǊ {hb!w tǊƻŦŜǎǎƛƻƴŀƭ ŀƴŘ tƭŀǘƛƴǳƳΦ ¢ƘŜǊŜΩǎ 

even PNG support for track icons, and as usual, fixes and enhancements to make the SONAR 

environment ever ƳƻǊŜ ǎǘŀōƭŜΦ ²ŜΩǊŜ ŀƭso introducing two new, semi-regular eZine features: 

ά!ƴŀǘƻƳȅ ƻŦ ŀ tǊƻƧŜŎǘέ ǘƘŀǘ ǎƘƻǿŎŀǎŜǎ real-world SONAR applicationsΣ ŀƴŘ ά.ƭƻƎ.Ŝŀǘέ ǘƻ point 

to ǎƻƳŜ ƻŦ ǘƘŜ /ŀƪŜǿŀƭƪ ōƭƻƎΩǎ άƎǊŜŀǘŜǎǘ ƘƛǘǎΦέ ¢ƘŜ ǿŜŀǘƘŜǊ ƻǳǘǎƛŘŜ Ƴŀȅ ōŜ ǘǳǊƴƛƴƎ ŎƻƭŘŜǊΣ ōǳǘ 

SONAR keeps getting hotter. Thanks for your support! ς Bill Jackson and the Cakewalk Team 

 

Direct Synth Recording: Record synth outputs as audio in real timeτthis can be 

simpler than bouncing, and has numerous applications. Record improvisational 

ƎŜǎǘǳǊŜǎ ǘƘŀǘ ŎŀƴΩǘ ōŜ ǊŜŎƻǊŘƛƴƎ ŀǎ ŀǳǘƻƳŀǘƛƻƴΣ άŦǳǘǳǊŜ-ǇǊƻƻŦέ ǾƛǊǘǳŀƭ ƛƴǎǘǊǳƳŜƴǘǎ 

parts with easy audio backup, capture randomized sounds, and more. 

 

±ƛǊǘǳŀƭ LƴǎǘǊǳƳŜƴǘ ά{ƳŀǊǘ aǳǘŜέ 5ƛǎŀōƭŜΥ This goes hand-in-hand with Direct 

{ȅƴǘƘ wŜŎƻǊŘƛƴƎΦ ²ƘŜƴ ŜƴŀōƭŜŘΣ {hb!wΩǎ ά{ƳŀǊǘ aǳǘŜέ mode for virtual 

instruments automatically mutes both the synth audio and MIDI tracks if either is 

muted. However, you can now disable this when doing Direct Synth Recording. 

 

PǊƻ/ƘŀƴƴŜƭ ά{ǘȅƭŜ 5ƛŀƭǎέ: ¢ƘŜȅΩǾŜ ōŜŜƴ ŀ ōƛƎ Ƙƛǘ ƛƴ aǳǎƛŎ /ǊŜŀǘƻǊ тΣ ǎƻ ǿŜ ǘƘƻught 

it was about time Style Dials became available as ProChannel modules for SONAR 

Professional and Platinum. The three modulesτGrit, Max, and Spaceτdo pretty 

much what ȅƻǳΩŘ ŜȄǇŜŎǘ ŦǊƻƳ the names.  

 

MixStrip Integration: The MixStrips in Music Creator 7 are like a baby ProChannel, 

and have become a very popular featureΦ {ƻΣ ǿŜΩǾŜ ŦƛƎǳǊŜŘ ƻǳǘ Ƙƻǿ ǘƻ ƛƴǘŜƎǊŀǘŜ 

MixStrips into SONAR Artist to give even more value in our least expensive version. 

!ƴŘ ǘƻ ǘƻǇ ƛǘ ƻŦŦΣ ǿŜΩǊŜ ƛƴŎƭǳŘing three Style Dial plug-ins. 
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Export and Bounce Presets: Previously you could create and save your favorite 

parameter presets for both exporting and bouncing, and take advantage of several 

included presets. However starting with Ipswich, the settings in the export and 

bounce dialogs now persist in projects and templates. 

  

PNG Support for Track Icons: The PNG (Portable Network Graphics) file format for 

graphics is much more advanced than the .BMP format. Now you can create, save, 

and import really great-looking track icons that include transparency so they can 

blend in with colors and backgrounds. 

 

Multiple Clip Export: When exporting audio, in addition to exporting specific 

tracks, buses, outputs, or the entire mix, you can now export multiple clips 

simultaneously. Choose άClipsέ under Bounce Settings to export each clip 

individually into a folder or other location, and give the file names a prefix.  

 

/ƭƛǇ 9ȄǇƻǊǘ ǿƛǘƘ 9ȄǘŜƴŘŜŘ ά¢ŀƛƭέ: When exporting clips, SONAR traditionally 

exported only the audio defined within the clip itself. For example if there was 

ŘŜƭŀȅ ƻǊ ǊŜǾŜǊōΣ ǘƘŜ άǘŀƛƭέ would stop when the clip ended. Starting with Ipswich, 

now you can specify a time to accommodate a ŎƭƛǇΩǎ tail when exporting. 

 

Workflow Enhancements and Fixes: This update offers multiple fixes, including 

some intermittent ones that were difficult to track down (like the occasional icon 

corruption upon opening a project). Among others tƘŜǊŜΩǎ ŀƴƻǘƘŜǊ {ǘŀŦŦ ±ƛŜǿ ŦƛȄΣ 

Start Screen improvements, and more accurate AudioSnap transient detection. 

 

Anatomy of a SONAR ProjectτLoop-Based Video Soundtrack: This article 

describes some of the artistic and technical decisions, as well as the techniques, 

when using SONAR and its included content to create an instrumental soundtrack 

under tight deadlines for a product video. 

 

Review |Ploytec PL2 Miniature Hardware Synthesizer: LǘΩǎ ǎƭƛƎƘǘƭȅ ƭŀǊƎŜǊ ǘƘŀƴ ŀƴ 

ƛŎŜ ŎǳōŜΣ ōǳǘ ƛǘΩǎ ŀ ǘǊǳŜ hardware synthesizer with zero latency and sounds that 

are, shall we say, not exactly strings, French hoǊƴǎΣ ŀƴŘ ǇƛŀƴƻǎΦ LǘΩǎ ŎƻƳǇŀǘƛōƭŜ ǿƛǘƘ 

{hb!wΩǎ ǾƛǊǘǳŀƭ ƪŜȅōƻŀǊŘΣ ŀƴŘ ŜǾŜƴ ƻŦŦŜǊǎ ŀ Ƴǳƭǘƛ-client MIDI driver. 

 

BlogBeat: ! ǊƻǳƴŘǳǇ ƻŦ ŀ ŦŜǿ ƻŦ ǘƘŜ /ŀƪŜǿŀƭƪ .ƭƻƎΩǎ άƎǊŜŀǘŜǎǘ ƘƛǘǎΦέ Get that 

άŀƴŀƭƻƎ ǎƻǳƴŘέ ƛƴ {hb!wΣ avoid common mixing mistakes, learn what iLan 

.ƭǳŜǎǘƻƴŜ ŘƻŜǎ ǘƻ ƘŜƭǇ ƘƛƳ ǘƻǇ ǘƘŜ 95a ŎƘŀǊǘǎΣ ŘƛǎŎƻǾŜǊ ǘƛǇǎ ǘƻ ƳŀȄƛƳƛȊŜ {hb!wΩǎ 

efficiency for songwriters, and create more dynamic vocals. 
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How to Download Ipswich 
 

Open the Cakewalk Command Center. Please note that Cakewalk Command Center version 

1.1.2 is now available, so download it ƛŦ ȅƻǳ ƘŀǾŜƴΩǘ ŀƭǊŜŀŘȅ. There are two major changes: 

 

¶ The default time interval for checking for updates is now 0. This is because when the 

ŘŜŦŀǳƭǘ ǿŀǎ нп ƘƻǳǊǎΣ ǳǎŜǊǎ ǘƘƻǳƎƘǘ ǳǇŘŀǘŜǎ ǿŜǊŜƴΩǘ ŀǾŀƛƭŀōƭŜ ƛŦ ǘƘŜȅΩŘ ƻǇŜƴŜŘ ǘƘŜ 

program less than 24 hours before the update was posted. However, you can still 

ǎǇŜŎƛŦȅ ŀ ŘŜŦŀǳƭǘ ǘƛƳŜ ƛƴǘŜǊǾŀƭ ǘƻ ŎƘŜŎƪ ŦƻǊ ǳǇŘŀǘŜǎ ƛŦ ȅƻǳ ŘƻƴΩǘ ǿŀƴǘ {hb!w ǘƻ ŎƘŜŎƪ 

every time you go on line, and you can also go click on Settings and choose Check Now 

to check for updates at any time. 

¶ Editing the VST3 scan path from the Cakewalk Command Center has been removed. 

Unfortunately, exposing this for editing can cause issues with VST3 support. 

 

To download Ipswich itself, download from the core SONAR Artist, Professional, or Platinum 

category.  
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Direct (Real Time) Synth Recording   
Artist, Professional, Platinum 
 

Thanks to direct synth recording, bouncing is no longer necessary to convert a virtual synth 

output into audio because you can now record the synth audio in real time. The main 

advantages to real-time virtual instrument recording include: 

 

¶ /ŀǇǘǳǊŜ ƛƳǇǊƻǾƛǎŀǘƛƻƴŀƭ ƎŜǎǘǳǊŜǎ ǘƘŀǘ ŎŀƴΩǘ ōŜ ŎŀǇǘǳǊŜŘ Ǿƛŀ ŀǳǘƻƳŀǘƛƻƴ Řŀǘŀ 

¶ Capture randomized synth parameters that never repeat the same way twice 

¶ With multi-output instruments, record all outputs as audio without having to bounce 

each one individually 

¶ Record MIDI and audio simultaneously 

¶ Record an instrument output into multiple tracks simultaneously (e.g., if you want 

different processing on each one) 

¶ Easy and CPU-friendly layering by recording the same part with different instrument 

presets, or even editing the MIDI data and re-recording the part 

¶ άCǳǘǳǊŜ-ǇǊƻƻŦέ ǾƛǊǘǳŀƭ ƛƴǎǘǊǳƳŜƴǘ ǇŀǊǘǎ ōȅ ǊŜŎƻǊŘƛƴƎ ǘƘŜƳ ŀǎ ŀǳŘƛƻ ǘǊŀŎƪǎ  

 

SELECTING AN INSTRUMENT OUTPUT AS AN AUDIO TRACK INPUT 

 

!ƴ ƛƴǎǘǊǳƳŜƴǘΩǎ outputs show up as available inputs on the Input widget for any audio track. 

  

 



6 | P a g e 
 

Simply select the input as you would any other available audio signal, and arm record. Also note 

this works for Console view. If a project includes multiple instruments, each has its own input 

selector to avoid clutter. 

 

 
 

Recording works the same as recording audio, including punch recording, loop recording and 

take management, and of course you can record multiple outputs simultaneously on multiple 

tracks. 

 

Finally, in Ipswich the waveform preview button is next to the record button. The waveform 

preview button always shows the post-fader waveform. The record preview is always pre-fader. 

So if you press the waveform preview button during recording, it will switch to displaying the 

post-fader waveform; switching it off will return to displaying the (pre-fader) record preview. In 

other words, there are now implicitly two different tap points available for the preview.  
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Virtual LƴǎǘǊǳƳŜƴǘ ά{ƳŀǊǘ aǳǘŜέ 5ƛǎŀōƭŜ   
Artist, Professional, Platinum 
 

²ƘŜƴ ŜƴŀōƭŜŘΣ {hb!wΩǎ ά{ƳŀǊǘ aǳǘŜέ ƳƻŘŜ ŦƻǊ ǾƛǊǘǳŀƭ ƛƴǎǘǊǳƳŜƴǘǎ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ƳǳǘŜǎ ōƻǘƘ 

the synth audio and MIDI tracks if either one is muted. This is the preferred behavior with 

virtual instruments having multiple outputs, because you generally want to make sure all audio 

outputs are muted when you mute the MIDI track driving them.  

 

However, with direct synth recording there may be times when you want to mute some audio 

ƻǳǘǇǳǘǎ ōǳǘ ƴƻǘ ƻǘƘŜǊǎΣ ǎƻ ƛǘΩǎ ƴƻǿ ǇƻǎǎƛōƭŜ ǘƻ ŘƛǎŀōƭŜ ǎƳŀǊǘ ƳǳǘŜ ƛƴ ǘƘŜ .ǊƻǿǎŜǊΦ /lick the 

drop-down menu on the Synth tab to enable or disable smart mute. This is global and affects all 

synths. 
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ProChannel Style Dials   
Professional, Platinum 
 

 
 

{ǘȅƭŜ 5ƛŀƭǎ ǿŜǊŜ ƛƴǘǊƻŘǳŎŜŘ ƛƴ aǳǎƛŎ /ǊŜŀǘƻǊ тΩǎ aƛȄ{ǘǊƛǇǎ ŀǎ Ŝŀǎȅ-to-use, single-knob 

controlsτoften controlling multiple parameters simultaneouslyτto speed up workflow when 

looking for a specific effect. Because tƘŜȅΩǾŜ ǇǊƻǾŜƴ ǘƻ ōŜ surprisingly popular, ƛǘ ŘƛŘƴΩǘ ǎŜŜƳ 

ǊƛƎƘǘ ǘƘŀǘ ǘƘŜǎŜ ǿŜǊŜƴΩǘ ŀǾŀƛƭŀōƭŜ ǘƻ {hb!w ǳǎŜǊǎΦ 

 

So, the Style Dials have now been ported over to ProChannel versions for Professional and 

Platinum users. The names are pretty self-descriptive, but here are the basics. 

 

¶ Grit adds a little bit of dirt and distortion to signals. Try it on guitars, drums, and 

especially bass when you want it to stand out a bit in a mix. 

¶ Max ƛǎ ȅƻǳǊ ōŀǎƛŎ άƭŜǘΩǎ ǎǉǳŀǎƘ ǘƘƛǎ ǘƘƛƴƎέ ŘȅƴŀƳƛŎǎ ŎƻƴǘǊƻƭΦ LǘΩǎ ŀ ƎǊŜŀǘ ǿŀȅ ǘƻ ƭƛŦǘ ǇŀǊǘǎ 

a little higher in the mix without having to increase levels. 

¶ Space gives some quick reverb-ōŀǎŜŘ ŀƳōƛŜƴŎŜ ǿƘŜƴ ȅƻǳ ŘƻƴΩǘ ǿŀƴǘ ǘƻ ǘŀƪŜ ǘƘŜ ǘƛƳŜ 

to mess with a plethora of reverb parameters. It makes a fine ǇƭŀŎŜƘƻƭŘŜǊ ǳƴǘƛƭ ƛǘΩǎ ǘƛƳŜ 

ǘƻ ƳƛȄΣ ǿƘŜƴ ȅƻǳΩƭƭ ǇǊƻōŀōƭȅ ǿŀƴǘ ǘƻ ǳǎŜ ǘƘŜ .ǊŜǾŜǊō or REmatrix Solo. 

 

!ƴŘ ŦƻǊ ŀ ǇŜŜƪ ƛƴǘƻ ǘƘŜ ŦǳǘǳǊŜΣ ǿŜΩǊŜ ǇƭŀƴƴƛƴƎ ǎƻƳŜ ƳƻǊŜ {ǘȅƭŜ 5ƛŀƭǎ Χǎƻ ǎǘŀȅ ǘǳƴŜŘΦ 
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MixStrip Integration 
Artist 

 

LŦ ȅƻǳΩre a SONAR Artist user ǿƘƻΩǎ been looking 

longingly at the ProChannel in the Professional and 

Platinum versions, this is the update for you: MixStrips, 

first included in Music Creator 7, have now been 

integrated into SONAR Artist. And to kick things off, 

ȅƻǳΩǊŜ ƎŜǘǘƛƴƎ ǘƘŜ DǊƛǘΣ aŀȄΣ and Space Style Dialsτfor 

details, see the descriptions above. 

 

MixStrips add considerable value to the basic SONAR 

version, and give a taste of the ProChannel flavor. ²ƘŀǘΩǎ 

more, any future Style Dials introduced for Music Creator 

will also be compatiblŜ ǿƛǘƘ !ǊǘƛǎǘΩǎ aƛȄ{ǘǊƛǇǎΦ 
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Export and Bounce Presets    
Artist, Professional, Platinum 

 

Previously, you could create and save your favorite parameter presets for both exporting and 

bouncing. In the Bounce to Track(s) or Export Audio dialog boxes, you simply choose the 

desired preset from the drop-down menu. 

 

 
 

However for your added convenience, the settings in the export and bounce dialogs now persist 

in projects and templates (not the presets themselves). For example, if you change the settings 

in the Export dialog and save a project after that, the next time you load that project, those 

dialog settings will be restored. This is very useful when you want to return to the last settings 

used on a per-project basis.  
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PNG Support for Track Icons    
Artist, Professional, Platinum 
 

The PNG (Portable Network Graphics) file format for graphics is the most popular lossless image 

compression format on the internet. Unlike GIF, the compression algorithm used in PNG format 

graphics is not patented, and due to it also being lossless, PNG files do not have the artifacts 

associated with JPG files.  

 

For SONAR, the primary benefit with PNG files is that they support transparency correctly. 

Rather than a pixel either being transparent or not, PNG icons can support levels of opacity. 

This will allow for more modern-looking track icons in the future, and meanwhile, users can 

more easily take advantage of transparency for smooth blending with colors and backgrounds. 

 

 
 

When creating custom track icons, for best results scale the image size to 96 x 96 pixels. 

 

Also note that you can configure the size of small and large icons in the Cakewalk.ini file. (This is 

located in your user AppData folder. Windows defaults to hiding this folder, so you may need to 

open Folder Options and under the View tab, click Show hidden files, folders, and drives.) By 

default, small icons are 32x32 pixels and large icons are 48x48 pixels. To change the default 

size, use the following INI variables: 

 
[WinCake]  
SmallIconHeight=32  
LargeIconHeight=48  
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Multiple Clip Export    
Artist, Professional, Platinum 
 

When exporting audio, in addition to exporting specific tracks, buses, outputs, or the entire mix, 

you can now export multiple clips simultaneously. Clip export also exports virtual instrument 

track MIDI clips as audio. Simple instrument tracks automatically export clips to audio; with split 

instrument tracks, you also need to select the synth audio tracks before exporting. 

 

 
 

After selecting the clips you want to export, choose File > Export > Audio. Under Bounce 

Settings, for Source Category choose Clips. You can also choose a file name to precede the clip 

names. For example, if you export three clips named Riff01, Riff02, and Riff03, then choose a 

file name of Guitar Loops, the exported clips will be named Guitar Loops, Riff01.wav, Guitar 

Loops, Riff02.wav, and Guitar Loops, Riff03.wav.  

 

Remember that SONAR can also export and import Broadcast WAV files. Under Preferences > 

File > Audio Data, check Export Broadcast Waves By Default to time-stamp the clip locations on 

the timeline. If you also check Always Import Broadcast Waves At Their Timestamp, then these 

clips will be imported back to their original timeline locations. 

 



13 | P a g e 
 

 
 

¢ƘŜǊŜΩǎ ƻƴŜ Ŏŀǳǘƛƻƴ ƛƴǾƻƭǾŜŘ ƛƴ .ǊƻŀŘŎŀǎǘ ²!± ƛƳǇƻǊǘΥ {ƻƳŜ ƭƻƻǇ ŀƴŘ ǎŀƳǇƭŜ ƭƛōǊŀǊƛŜǎ ǘƛƳŜ-

stamp the files at arbitrary times, like 1:00:00 hours. If Always Import Broadcast Waves At 

Their Timestamp is checked, then these will import way down the timeline, so you may not be 

ŀǿŀǊŜ ǘƘŜȅΩǾŜ ōŜŜƴ ƛƳǇƻǊǘŜŘΦ  
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/ƭƛǇ 9ȄǇƻǊǘ ǿƛǘƘ 9ȄǘŜƴŘŜŘ ά¢ŀƛƭέ    
Artist, Professional, Platinum 
 

When exporting clips, SONAR traditionally exported only the audio defined within the clip itself. 

For example if there was delay or reverb, either as a track effect or as an effect inserted in a 

ŎƭƛǇΣ ǘƘŜ ŘŜƭŀȅ ƻǊ ǊŜǾŜǊō άǘŀƛƭέ ǿƻǳƭŘ ǎǘƻǇ ǿƘŜƴŜǾŜǊ ǘƘŜ ŎƭƛǇ ŜƴŘŜŘΦ ¢o include this tail with a 

clip effect, you needed to add enough silence at the clip end to accommodate the tail. With a 

track effect, you needed to add sufficient silence to the clip, render it, and then export.  

 

Starting with Ipswich, none of this is necessary because you can specify a time to accommodate 

a tail when exporting a clip. Simply choose Preferences > Audio Data, and enter the desired Clip 

Tail Duration. There is no practical limitation on how long the tail can be.  
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Fixes and Workflow Enhancements 
Artist, Professional, Platinum 

 

Fixed issues where: 

 

¶ In some cases adding a user transient marker in Audio Snap could cause other markers 

to stop drawing (disappear) 

¶ Track icons could become distorted when opening projects 

¶ Undoing overlapping clips could leave empty lanes 

¶ Splitting notes using CAL scripts could cause crash 

¶ Track folder would move to the bottom of view when a track was added to it 

¶ Step sequencer clips were blank on tracks with Drum Maps 

¶ Shift-click to extend selection ŘƛŘƴΩǘ ǿƻǊƪ in the Track view 

¶ Adjacent punch recording could unexpectedly create a new lane 

¶ Dragging audio clips from browser would create an additional lane in the Track Lanes  

¶ Selected clips could disappear when cropping using auto crossfade 

¶ Audio Snap was generating superfluous user transients with low level audio material 

¶ Dotted note drawing in the staff view needed improvement  

¶ PRV keyboard could be misaligned from note pane when opening after zooming 

¶ Zoom tool ŘƛŘƴΩǘ ŀƭǿŀȅǎ ǊŜǾŜǊǘ back to smart tool with press-hold gesture 

¶ Project bitmaps ŘƛŘƴΩǘ display completely when a project was spread across two screens 

¶ Press - hold hotkeys for tools were not working properly 

¶ The setting άAllow only one project at a timeέ in preferences was causing the Start 

Screen to open unexpectedly.   

¶ Some language characters were not working properly with start screen  

¶ Clicking on an empty colors box in Preferences - colors resulted in "Parameter is 

incorrect" errors  
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Review: Ploytec PL2 Minature Hardware Synthesizer 
 

By Craig Anderton 

 

And now for something completely different: A 

ƘŀǊŘǿŀǊŜ ǎȅƴǘƘŜǎƛȊŜǊ ǘƘŀǘΩǎ ǘƘŜ ǎƛȊŜ ƻŦ ŀƴ 

ƻǾŜǊŀŎƘƛŜǾƛƴƎ ƛŎŜ ŎǳōŜΣ ŀƴŘ Ŏƻǎǘǎ ǳƴŘŜǊ ϷмллΦ ²ƘŀǘΩǎ 

ƳƻǊŜΣ ƛǘ Ƙŀǎ ƛǘǎ ƻǿƴ άƳŀŘ ǎŎƛŜƴǘƛǎǘέ ǇŜǊǎƻƴŀƭƛǘȅτif you 

like Commodore-64 SID chips, speech synthesizers, 

circuit bending, and rude noises as well as musical 

ǎƻǳƴŘǎΣ ǘƘƛǎ ǿƛƭƭ ŜƴǘŜǊǘŀƛƴ ȅƻǳ ŦƻǊ ƘƻǳǊǎΦ bƻΣ ƛǘΩǎ ƴƻǘ 

about strings, pianos, and Moogy bass lines, but 

SONAR and Rapture Pro already give you plenty of 

those. This is a whole other animal. 

 

There are two PL2 models, the black MIDI one and the 

white USB one (nicknamed the Leukos). The black version has a 5-pin MIDI in, RCA phono audio 

output, and mini-¦{. ƧŀŎƪ ŦƻǊ ǇƻǿŜǊΤ ƛǘΩǎ ȅƻǳǊ ōŀǎƛŎ ǊŜŀƭ-time hardware synth. The Leukos, 

reviewed here, is designed to work with computers and is both Mac and Windows-compatible. 

It hooks into your computer via USB (although it also has a 5-pin DIN connector), and the RCA 

photo output feeds your mixer, audio interface, or powered speaker.  

 

Lƴ ǘŜǊƳǎ ƻŦ ƳƻŘǳƭŜǎΣ ƘŜǊŜΩǎ ōŀǎƛŎŀƭƭȅ ǿƘŀǘ ƛǘ ƘŀǎΦ bƻǘŜ ǘƘŀǘ ǘƘƛǎ Ŏƻƻƭ ŀǊǘǿƻǊƪ ƛǎ not the 

accompanying editing software (Windows, Mac 10.6 and above, and iPad), but it does get 

ŀŎǊƻǎǎ ǘƘŜ ŜƭŜƳŜƴǘǎ ƛƴ ǘƘŜ t[нΩǎ ǘƻƻƭƪƛǘΦ 
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TWEAKING THE SOUNDS 

 

Just about every parameter can be controlled via MIDI Continuous Controller messages, so 

ǿƘƛƭŜ ƛǘΩǎ ǘŜƳǇǘƛƴƎ ǘƻ ǳǎŜ ŀ ƭƛǘǘƭŜ ǇƻǊǘŀōƭŜ ƪŜȅōƻŀǊŘ ǘƻ ŎƻƴǘǊƻƭ ǘƘŜ [ŜǳƪƻǎΣ ƘŀǾƛƴƎ ŀ ŎƻƴǘǊƻƭƭŜǊ 

with lots of assignable knobs, buttons, and sliders is a better option. However, the Editor also 

provides the control you need to tweak sounds. 

 

 
 

CǳǊǘƘŜǊƳƻǊŜΣ tƭƻȅǘŜŎ ƻŦŦŜǊǎ ŦǊŜŜ ǘŜƳǇƭŀǘŜǎ ŦƻǊ bŀǘƛǾŜ LƴǎǘǊǳƳŜƴǘǎΩ wŜŀƪǘƻǊΣ .ŜƘǊƛƴƎŜǊ 

BCR2000, Korg nanoKontrol2, Korg taktile 49, Nord Modular G2, Novation Impulse 49/61, 

Roland A300/500/800 pro, Terrasoniq Area61, TouchAble (iOS), TouchOSC (iOS) and Yamaha 

KX25/49/61. Although pre-²ƛƴŘƻǿǎ мл ƻǇŜǊŀǘƛƴƎ ǎȅǎǘŜƳǎ ǿŜǊŜƴΩǘ Ƴǳƭǘƛ-client with MIDI, 

ǘƘŜǊŜΩǎ ŀ ŦǊŜŜ ŘƻǿƴƭƻŀŘŀōƭŜ ŘǊƛǾŜǊ ǘƘŀǘ ƭŜǘǎ ȅƻǳ Ǌǳƴ {hb!w ŀƴŘ 9ŘƛǘƻǊ ŀǘ ǘƘŜ ǎŀƳŜ ǘƛƳŜΧǾŜǊȅ 

ǘƘƻǳƎƘǘŦǳƭΦ ¸ƻǳ ŘƻƴΩǘ need ǘƘŜ ŘǊƛǾŜǊΣ ōǳǘ ƛǘΩǎ ŜǎǎŜƴǘƛŀƭ ƛŦ ȅƻǳ ǿŀƴǘ ǘƻ Řƻ ƳƻǊŜ ǘƘŀƴ Ƨǳǎǘ Ǉƭŀȅ 

the synth in real time and tweak it with the editing software. 

 

LIMITATIONS 

 

At this price and given the small size, itΩǎ only reasonable to expect some limitations. The main 

one is it plays only two notes at a time, although you can configure these as two individual 

ƴƻǘŜǎΣ ǎǘŀŎƪŜŘ ƴƻǘŜǎΣ ƻŎǘŀǾŜǎΣ ƻǊ ƳƻƴƻΦ ¢ƘŜǊŜΩǎ ŀƭǎƻ ƴƻ ŦƛƭǘŜǊ ŜƴǾŜƭƻǇŜΣ ǘƘŜ ŎƘƻƛŎŜ ƻŦ 
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waveforms is limited, there are no onboard controls (so you need to use the editing software or 

an external controller to make it do interesting things), and the PL2 does require a certain 

amount of MIDI literacy. 

 

COOLNESS 

 

In addition to the unique sonic character, a huge pluǎ ƛǎ ǘƘŀǘ ǘƘŜǊŜΩǎ ƴƻ ƭŀǘŜƴŎȅτafter all, this is 

truly a hardware synth, and MIDI-over-¦{. ƛǎ ƭƛƎƘǘƴƛƴƎ ŦŀǎǘΦ LǘΩǎ ǊŜŦǊŜǎƘƛƴƎ ǘƻ ƘŀǾŜ ǎƻƳŜǘƘƛƴƎ 

ƭƻŀŘŜŘ ƛƴǘƻ ŀ ŎƻƳǇǳǘŜǊ ǿƘŜǊŜ ǘƘŜǊŜΩǎ ȊŜǊƻ ŘŜƭŀȅ ōŜǘǿŜŜƴ ǿƘŀǘ ȅƻǳ Ǉƭŀȅ ŀƴŘ ǿƘŀǘ ȅƻǳ ƘŜŀǊΣ 

ŀƴŘ ŀƭǘƘƻǳƎƘ ǘƘŜ ŜŘƛǘƻǊΩs internal on-ǎŎǊŜŜƴ ƪŜȅōƻŀǊŘ ƛǎƴΩǘ ǘƻǳŎƘ-ǎŜƴǎƛǘƛǾŜΣ ȅƻǳΩƭƭ ōŜ ƎƭŀŘ 

{hb!wΩǎ ǾƛǊǘǳŀƭ ŎƻƴǘǊƻƭƭŜǊ ƛǎΦ J 

 

My favorite feature is that you can swap firmware via the editor program. Loading version 2.56 

ǘǳǊƴǎ ǘƘŜ t[н ƛƴǘƻ ŀ ǎǇŜŜŎƘ ǎȅƴǘƘŜǎƛȊŜǊ ǘƘŀǘΩǎ ƴƻ {ƛǊƛΣ ōǳǘ does let you string together phonemes 

and create all kind of Commodore-64 type verbal nonsense sounds. To me this cries out for a 

ƭƻƻǇ ƭƛōǊŀǊȅΣ ōǳǘ ǘƘŜƴ ŀƎŀƛƴΣ LΩƳ ƪƛƴŘ ƻŦ ǿŜƛǊŘ ǘƘŀǘ ǿŀȅΦ 

 

For more information and lots of audio examples, check out PloytecΩǎ product landing page and 

the product landing page for the US distributor, Eleven Dimensions Media.  

 

CONCLUSIONS 

 

I definitely want to do a little sampling, because some of the sounds from this Lilliputian box are 

ƛƴŘŜŜŘ ǳƴƛǉǳŜΦ hǾŜǊŀƭƭ ǘƘƛǎ ƛǎ ŀ Ŧǳƴ ǎȅƴǘƘΣ ŘƻŜǎƴΩǘ Ŏƻǎǘ ƳǳŎƘΣ ŘƻŜǎƴΩǘ ǘŀƪŜ ǳǇ ŀ ƭƻǘ ƻŦ ǎǇŀŎŜΣ ŀƴŘ 

Ƙŀǎ ŀ ƘƛƎƘ Ŧǳƴ ŦŀŎǘƻǊΦ ¸ŜǎΣ ƛǘΩǎ ŀ ǉǳƛǊƪȅ ƭƛǘǘƭŜ ƛƴǎǘǊǳƳŜƴǘΧōǳǘ ǘƘŀǘΩǎ ƻƴŜ of its charms.  

  

http://ploytec.com/pl2/
http://www.11dmedia.com/ploytec-pl2---palm-sized-synthesizer.html
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Anatomy of a SONAR Project: Loop-Based Video Soundtrack 
 

By Craig Anderton 

 

Some people think loops are all about DJs and dance music, but loops have many other uses. 

One of my favorites is putting together a quick soundtrack. This article describes the process, 

and hopefully, will provide some inspiration on one of the many ways to use loops. (Also note 

that putting together soundtracks for presentations, commercials, videos, and the like can 

provide an additional income stream for your studio.) 

 

I recently did five product videos for Neat Microphones. My personal music library provided 

soundtracks for two of them, but nothing was suitable for the other three. Fortunately, I was 

able to create two of the soundtracks using SONAR Platinum and its content; for the other one, 

I still used loops and SONARΣ ōǳǘ Ǿƛŀ ¦ŜōŜǊǎŎƘŀƭƭΩǎ 9ƭŀǎǘƛƪ ǇƭŀȅŜǊ ŀƴŘ ŀ ŎƻǳǇƭŜ ƻŦ ǘƘŜƛǊ ƭƻƻǇ 

libraries. 

 

The primary object in this type of project is not to repeat loops endlessly, but to find 

compatible loops that work well together, then ŀƭǘŜǊƴŀǘŜ ǘƘŜƳ ǘƻ ŎǊŜŀǘŜ ǎƻƳŜǘƘƛƴƎ ǘƘŀǘΩǎ 

similar, but varying. Dominant themes need to re-occur periodically, with occasional surprises 

thrown because paradoxically, having something repeat indefinitely draws attention to itselfτ

which you ŘƻƴΩǘ want in a soundtrack whose main purpose is solely to support the visuals and 

narration.  

 

The project had four tracks: 1 and 2 for percussion, 3 and 4 for melodic elements. 

 

THE MELODIC HOOKS 

 

First up: finding a pair of loops that can alternate to provide a main theme. In the Browser, at 

this early stage L ǳƴŎƘŜŎƪ άtǊŜǾƛŜǿ ŀǘ Iƻǎǘ ¢ŜƳǇƻέ ǘƻ ƎŜǘ ŀ ǎŜƴǎŜ ƻŦ ǘƘŜ ƴŀǘƛǾŜ ǘŜƳǇƻτLΩŘ 

rather not stretch more than needed. Because the narration was quite fast-paced, any music 

needed to stay out of the way of the message and not be a distraction. So, I started browsing 

{ŀƳǇƭŜ aŀƎƛŎΩǎ aƛƴƛƳŀƭ ¢ŜŎƘ-House folder, which is a suitable genre. 
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Overall view of the completed project 

 

mth_syn_125_filterrise_G (chartreuse clips in Track 3) and mth_com_130_vinyl_F_Rex (green 

ŎƭƛǇǎ ƛƴ ¢ǊŀŎƪ пύ ǿŜǊŜ ƛŘŜŀƭΣ ŜǎǇŜŎƛŀƭƭȅ ōŜŎŀǳǎŜ ǘƘŜȅ ŘƛŘƴΩǘ ƘŀǾŜ ǘƻ ǎǘǊŜǘŎƘ ƳǳŎƘ ǘƻ ŎƻƴŦƻǊƳ ǘƻ 

the 120 BPM tempo. However, mth_syn_125_filterrise_G became too bright in the last two 

measures, so I kept the first two, bounced the clip to itself, and re-άƎǊƻƻǾŜ-ŎƭƛǇǇŜŘέ ǘƘŜ ŦƛǊǎǘ 

two measures to loop them.  

 

With a two-minute video you also need some variations, which required a couple more melodic 

loops. After a little more browsing, mth_mus_127_ubertek_G_Rex (violet clips in Track 3) did 

ǘƘŜ Ƨƻō ōǳǘ L ŎƻǳƭŘƴΩǘ ŦƛƴŘ ŀƴȅǘƘƛƴƎ ŜƭǎŜ ƛƴ ǘƘŜ aƛƴƛƳŀƭ ¢ŜŎƘ-House folder for a break element 

that would appear briefly, then go away. Deep Tech House is a similar genre, and the file 

dth_com_125_amour2_Am_Rex (dark blue clip in Track 4) was ideal. The last melodic element, 

mth_music_130_B_iquifilter_Rex (light blue in Track 3), sounded appropriate for a break 

toward the beginning. 

 

Summing up, the loops in Tracks 3 and 4 provided a combination of consistency, with enough 

other elements added in isolation or layered to provide variations. 

 

I GOT RHYTHM 

  

Next up: ŦƛƴŘƛƴƎ ŀ ōŀŎƪƎǊƻǳƴŘ ǇǳƭǎŜΦ IŜǊŜΣ ȅƻǳ ŘƻƴΩǘ ǿŀƴǘ ŀǎ ƳǳŎƘ ǾŀǊƛŜǘȅ ŀǎ ǘƘŜ ƳŜƭƻŘƛŎ ƭƻƻǇǎ 

ōŜŎŀǳǎŜ ǘƘŜ ǊƘȅǘƘƳ ƴŜŜŘǎ ǘƻ ǇǊƻǾƛŘŜ ŎƻƴǎƛǎǘŜƴŎȅΦ CƻǊ ǘƘƛǎΣ ƛǘΩǎ helpful to find a compatible loop 

and stretch it the entire length of the soundtrack, then start arranging the melodic elements. 

!ŦǘŜǊ ǘƘŜǊŜΩǎ ŀ ƎƻƻŘ ƳŜƭƻŘƛŎ ŦƭƻǿΣ ǘƘŜƴ ȅƻǳ Ŏŀƴ ŀŘŘ ǾŀǊƛŀǘƛƻƴǎ ǘƻ ǘƘŜ ǇŜǊŎǳǎǎƛǾŜ ǘǊŀŎƪǎΦ 

 

There are two workhorses here, mth_drlp_127_dan'sgroove_Rex (red clips in Track 1) and 

various tambourine parts from my EDM Percussion Library (orange clips in Track 1). The clips in 

Track 2 add more varietyτmth_top_130_swivelclick_Rex (tan), dth_drlp_125_karting1_Rex 


